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Rugged TROLL® 100 and 200 Operator's Manual
The Rugged TROLL 100 and 200 instruments are designed to 
measure pressure, level, and temperature in natural groundwater 
and surface water. They also can be used at industrial sites, landfills, 
and other installations. 

Both instruments have completely sealed bodies that contain an 
absolute (non-vented) pressure sensor, temperature sensor, real-
time clock, microprocessor, lithium battery, and internal memory.

The Rugged TROLL 100 is designed to hang by a backshell hanger 
from a suspension wire. The Rugged TROLL 200 can utilize the 
backshell hanger or can connect to a cable for easy top-of-well 
RS485 communications via RuggedReader® handheld PC or laptop 
PC. Additionally, Rugged TROLL 200 cables with stripped and 
tinned cable ends can communicate with data loggers, TROLL® Link 
telemetry systems, or PLC devices via RS485 or SDI-12.

Communication ACCESSORIES
USB or RS232 docking station for the Rugged TROLL 100 or 200•	

USB or RS232 Rugged TROLL® Com for the Rugged TROLL 200 or •	
Rugged BaroTROLL® instrument

Win-Situ® 5 control software for programming and downloading•	

Optional software: Win-Situ® Baro Merge™ for barometric •	
compensation; Win-Situ® Mobile for the RuggedReader 
handheld PC; Win-Situ® Sync to transfer downloaded data logs 
from a RuggedReader to a laptop/desktop PC

Other Accessories
Rugged TROLL 100: suspension cable; RuggedReader handheld •	
PC; Rugged BaroTROLL for logging barometric pressure data

Rugged TROLL 200: suspension cable; RuggedReader device; •	
Rugged BaroTROLL for logging barometric pressure data; SDI-12 
compatible cable with stripped and tinned uphole termination; 
RS485 compatible cable with stripped and tinned uphole 
termination; or Modbus/RS485 top-of-well cable

Rugged TROLL 200 cable suspension kit: Use this to create a •	
weight-bearing loop capable of suspending up to 100 lbs (45.4 kg) 
of cable and instrument

Getting Started
You will need:

Rugged TROLL 100 or 200 instrument•	
USB or RS232 docking station or Rugged TROLL Com (for •	
Rugged TROLL 200 and Rugged BaroTROLL). RS232 model 
needed for connection to a RuggedReader device.
In-Situ Software/Resource CD or Internet connection •	
Desktop / laptop PC or RuggedReader handheld PC•	

Install software from the In-Situ Software CD or A.	
www.in-situ.com.
Win-Situ 5 Software1.	

Click the Win-Situ 5 link and follow the instructions. •	

For a USB docking station, be sure to select the “Install USB •	
Drivers” option.

Win-Situ Mobile Software (for the RuggedReader)2.	

Click the Win-Situ Mobile link and follow the instructions to •	
install Win-Situ Software Manager (desktop component of Win-
Situ Mobile). 

If running Windows® XP or earlier, also install Microsoft® •	
ActiveSync® 4.5 or higher (not required for Windows Vista™). For 
Windows 7, download and install the Windows Mobile Device 
Center software to communicate with the RuggedReader unit.

To install Win-Situ Mobile on the RuggedReader: connect the •	
RuggedReader to the PC via USB cable; establish a connection 
via ActiveSync; launch the Win-Situ Software Manager; click 
Win-Situ Mobile; click Install. Be sure to have your In-Situ Software 
License Certificate handy.

Win-Situ Baro Merge Software 3.	

Install Baro Merge software if you plan to post-correct level data •	
to compensate for barometric pressure.

Win-Situ Sync Software4.	

Install Win-Situ Sync if you want to automatically transfer •	
downloaded log files from a RuggedReader to a PC. 

Connect to the Rugged TROLL Docking Station  B.	
(Rugged TROLL 100 or 200) 
Unscrew and remove the •	
hanger from the Rugged 
TROLL instrument. 

Invert the instrument. Align •	
the notch on the Rugged 
TROLL body with the tab 
on the rim of the docking 
station to ensure the pins are 
mated for communication. 

Place the Rugged TROLL into •	
the docking station. 

Connect the docking station cable to the computer.•	

TIP: The hanger is the only removable part of the Rugged TROLL 
instrument. Do not attempt to take the instrument apart. There are no 
user-serviceable parts in the instrument body. 

1 2 3
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Connect to the Rugged TROLL Com (Rugged C.	
TROLL 200 and Rugged BaroTROLL)
Refer to the Rugged TROLL Com communication device •	
instruction sheet.

TIP: The Rugged TROLL Com requires a minimum of 8 VDC. If you lose 
connection to your instrument, particularly over long cable distances, 
replace the Rugged TROLL Com battery.

SDI-12 Wire Connections (stripped and tinned only)D.	
Black = ground•	
Red = 12 V supply line•	
Blue = serial data line•	

Remaining wires should be terminated (grounded) at the data 
recorder. For more information, refer to the Rugged TROLL 200 
cable instruction sheet.

RS485 Wire Connections (stripped and tinned only)E.	
Black = ground•	
Red = 12 V supply line•	
Blue = RS485 (+)•	
Green = RS485 (-)•	

Remaining wires should be terminated (grounded) at the data 
recorder.

Device  
is not  

connected

C:\Documents and Settings\[Login]\My Documents\WinSitu Data\

2 Check the 
COM port

3 Connect to the 
Rugged TROLL 

Data tab

Site Data folder

Fig. 1. Win-Situ Data tab on first connection

Device is connected 

Home tab

Clock sync

Fig 2. Home tab with device readings

Site box

Programming the Rugged TROLL 100 or 200

Launch the Software A.	

Start Win-Situ by double-clicking the desktop shortcut 1.	 . 
Win-Situ launches at the Data tab, shown in Fig. 1.

When you launch for the first time, the software may ask if 2.	
you want to select a COM port. Do one of the following:

Answer Yes to the prompt, then check or change the port in the •	
Comm Settings dialog, and click OK  to close it.

Answer No to bypass this step.•	

The Win-Situ default is COM 1. For USB communication, be sure to 
select the correct COM port. See the sidebar below.

Win-Situ asks if you want to connect to the device. If the 3.	
Rugged TROLL is connected to your computer as shown on 
above, answer Yes. 

Software will connect and display a reading of all supported 4.	
parameters in the Home tab (Fig. 2).

Set the ClockB.	
Data collection schedules depend on the device clock, shown with 
the system (PC) clock near the top of the screen when connected 
(Fig. 2). If the device clock is red, synchronize it to the system clock 
by clicking the Clock Sync button (Fig. 2).

Create a SiteC.	
Logged Rugged TROLL data are organized by the site where the 
data were logged. You will need a site when setting up a data log. 
Follow the steps below to create a new site: 

On the Data tab, click the Site Data folder (Fig. 1).•	

Select File menu > New > Site. •	

Enter a short, descriptive name—for example, a project, well, •	
river, gaging station, town, nearby landmark, etc. (max: 32 
characters).  

Enter any additional options you want, and then click SAVE •	  

. 

To set the new site in the Rugged TROLL: Return to the Home tab, •	
click the down arrow beside the site box (Fig. 2), and select your 
new site. 

Which USB Port Am I Using?

When a USB Docking Station is connected, the drivers that were 
downloaded with Win-Situ 5 are installed. After installation, 
check which COM port the connected USB Docking Station is 
using:

Windows 2000, Windows XP:•	  Control Panel > System > 
Hardware tab > Device Manager > Ports. Click the plus sign 
to display the ports.
Windows Vista:•	  Control Panel > System > Device Manager 
(User permission required) > Ports. Click the plus sign to display 
the ports.
Windows 7:•	  Control Panel > System > Device Manager > Ports.  Click 
the arrow to display the ports.

Remember the port number. You will need it to connect to the 
instrument in Win-Situ software.
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Set up a Data LogD.	

Click the Logging tab •	  .

Click the “New” button •	   at the bottom of the Logging 
tab.

The Logging Setup Wizard will prompt you through the 
configuration of a data log. For details, refer to the Win-Situ Help 
menu. 

 TIP:  When logging Level (DTW or Surface), select the option “Set First 
Logged Reading to____” for the Level Reference.  Be sure to select a 

Scheduled start, so the log will start automatically.

 TIP:  When logging Depth, choose a Scheduled start, or start the log 
before disconnecting by selecting it in the Logging tab and clicking 

“Start” .

E. Disconnect and Deploy the Instrument
Exit the software (File menu > Exit). •	

Remove the Rugged TROLL from the docking station or Rugged •	
TROLL Com. 

Connect to the backshell hanger and wire to the cable.  Be sure •	
to replace the cover for the top-of-well connector.

Install the device in the field location.•	

TIP: A Scheduled log will start at its programmed start time only if the 
device clock is correctly set (see page 2).

Downloading the Logged Data
Retrieve the Rugged TROLL 100 by pulling up the suspension •	
cable. Dry the instrument and remove the hanger. Place the 
Rugged TROLL 100 in the docking station (see page 1) and 
establish a software connection.

For the Rugged TROLL 200, remove the cap from the cable and •	
attach the Rugged TROLL Com. Connect the Rugged TROLL 
Com to a PC or RuggedReader device and establish a software 
connection.

Click the Logging tab •	  and then the log. The symbol  
shows the log is running. If the log stopped on schedule, the symbol 

is .

TIP:  It is not necessary to stop the log before downloading, but if you 

want the device to stop logging, press “Stop” , or suspend it by 

pressing “Pause” . Remember to resume the log if suspended!

To download, press the “Download” button •	  and 
select a download option. The log will be copied to the PC or 
RuggedReader device.

TIP: Use Win-Situ Sync to transfer downloaded logs from a 
RuggedReader to a desktop or laptop PC running Win-Situ. This will 

assure that the logs are placed in the Win-Situ working directory. 
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Rugged 

TROLL data)
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Rugged BaroTROLL

Rugged TROLL

Fig. 3. Rugged BaroTROLL & Rugged TROLL deployment

Rugged BaroTROLL Instrument
The Rugged BaroTROLL measures and logs barometric pressure 
and temperature in air. This data can be used to correct the Rugged 
TROLL 100 and 200 data by compensating for barometric pressure 
effects during the course of a log. 

Programming the Rugged BaroTROLL
Connect as for the Rugged TROLL instrument.•	
Program as for the Rugged TROLL. Be sure to sync the clock! The •	
measurements can be quite far apart as long as they cover the 
same general time period as the Rugged TROLL log. 
If the Rugged TROLL log used a reference (“Set first logged •	
reading to”), the Rugged BaroTROLL log should start before the 
Rugged TROLL log to ensure barometric pressure at the time of 
the first reading is captured.
Disconnect, attach the hanger, and deploy suspended or lying •	
in a protected location above water level, near the submerged 
Rugged TROLL 100 or 200. One possibility is shown in Fig. 3. 

DO NOT submerge a Rugged BaroTROLL instrument.

Download data as for the Rugged TROLL 100 and 200. •	
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Correcting for Barometric pressure
As shown in Fig. 3, the Rugged TROLL 100 and 200 instruments 
measure all pressure forces detected by their absolute pressure 
sensors. These forces include barometric (also called atmospheric) 
pressure and the pressure of the water above the sensor. As a 
result, logged data will show the effects of changes in barometric 
pressure. These effects can be removed manually (see the technical 
note “Manual Barometric Correction” in the Technical Resources 
section of the In-Situ website). To automatically remove barometric 
pressure effects, use Win-Situ Baro Merge software to post correct 
non-vented water level data. 

Using Baro Merge Software
You will need: 

Win-Situ Baro Merge and Win-Situ 5 installed on a desktop/•	
laptop PC
One or more Rugged TROLL logs in your Win-Situ working •	
directory
A Rugged BaroTROLL log in your Win-Situ working directory •	
covering the time period of the Rugged TROLL log(s) to be 
corrected

Launch Baro Merge from the desktop shortcut or the 1.	
Win‑Situ 5 Tools menu.

In the main window, select “Use a BaroTROLL file” for the 2.	
compensation method (Fig. 4). 

TIP: Information on the other two compensation methods may be 
found in Baro Merge Help (press F1 in Baro Merge).

Fig 4. Baro Merge options with BaroTROLL file method selected

	Click 3.	   to select a Rugged BaroTROLL log file. (Baro 
Merge displays these automatically by site when they are in 
the proper location.) 

Click the plus sign to expand the site and display the logs. •	
Check •	  the Rugged BaroTROLL file you want to use, then 
click OK  . 

The main window returns to the screen with the Rugged 4.	
BaroTROLL log file displayed (Fig. 4). Click Next  to 
continue.  

Baro Merge reads and displays the values in the Rugged 5.	
BaroTROLL log. Edit the values if you wish, or click Next  
to continue. 

TIP: For details on adding or editing values and time stamps in the table, 
see Baro Merge Help (search for “Manual Entry”) .

	Now choose the Rugged TROLL log file(s) you wish to 6.	
correct  (shown automatically when in the proper location). 

You may check •	 R as many files as you like. For best results 
the time stamps in the Rugged BaroTROLL log and the 
Rugged TROLL log(s) should overlap. (Baro Merge will use 
the first and last barometric values for Rugged TROLL data 
points beyond the barometric data time stamps.)

	Click OK 7.	  . The barometric compensation is applied. 
When processing is complete, click OK again.

	Click 8.	   to close Baro Merge. 

	The compensated log files may be viewed or exported from •	
the Data tab in Win-Situ. The original Rugged TROLL log file 
is not changed.  A corrected log file with the same name 
and path is created with the file extension “–BaroMerge.wsl.” 
For more information, refer to the Win-Situ Baro Merge •	
technical note at www.in-situ.com.

Warranty Provisions
In-Situ Inc. warrants the Rugged TROLL 100 and 200 and Rugged 
BaroTROLL for one (1) year from date of purchase against defects in 
materials and workmanship under normal operating conditions. To 
exercise this warranty, contact Technical Support at the phone or 
e-mail address below for a return material authorization (RMA) and 
instructions. Complete warranty provisions are posted on our web 
site (www.in-situ.com).

How to Contact Us
Technical Support:	 800 446 7488
(Toll-free 24 hours a day in the U.S. and Canada)
Mailing/Shipping Address:	 In-Situ Inc.
	 221 East Lincoln Ave.
	 Fort Collins, CO 80524
	 USA
Phone:	 970 498 1500
Fax:	 970 498 1598
Internet:	 www.in-situ.com
E-mail:	 support@in-situ.com

To Obtain Repair Service (U.S.)
If you suspect that your Rugged TROLL 100/200 or Rugged 
BaroTROLL is malfunctioning and repair is required, you can help 
assure efficient servicing by following these guidelines: 

Call or e-mail In-Situ Technical Support (support@in-situ.com). •	
Have the product model and serial number handy.
Be prepared to describe the problem, including how the •	
instrument was being used and the conditions noted at the time 
of the malfunction. 
If Technical Support determines that service is needed, they will •	
ask that your company pre-approve a specified dollar amount 
for repair charges. When the pre-approval is received, Technical 
Support will assign an RMA (Return Material Authorization) 
number.
Clean the instrument and/or cable. Decontaminate thoroughly if it •	
has been used in a toxic or hazardous environment.  
Carefully pack your instrument and/or cable in a suitable shipping box.•	  
Mark the RMA number clearly on the outside of the box with a •	
marker or label.
Send the package, shipping prepaid, to ATTN: Repairs, at the •	
address above.

The warranty does not cover damage during transit. We recommend 
the customer insure all shipments. Warranty repairs will be shipped 
back prepaid.

Outside the U.S.
Contact your international In-Situ distributor for repair and service 
information.
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Operational Temp. Range 32 to 122° F (0 to 50° C)

Storage Temp. Range -40 to 176° F (-40 to 80° C)

Calibrated Temp. Range 32 to 122° F (0 to 50°C)

Diameter 1.03 in (2.62 cm) OD

Length 5.68 in (14.43 cm)

Weight 0.37 lb (170 g)

Materials Titanium body; Delrin® nose 
cone, hanger, backend

Output Options Rugged TROLL 100: USB or 
RS232 via docking station

Rugged TROLL 200: USB or 
RS232 via docking station; 
Modbus/RS485 or SDI-12 via 
Rugged TROLL 200 cable

Battery Type 3.6 V lithium internal battery

Battery Life 5 years or 2M readings1

External Power Rugged TROLL 100: NA 
Rugged TROLL 200: 8-36 VDC

Measurement Current 14 mA typical

Idle Current (network activity only) 200 µA typical

Sleep Current (no network activity) 20 µA typical

Memory 1.0 MB

Data Records 
     Date/time + 1 parameter 
     Date/time + 2 parameters 
     Date/time + 3 parameters

 
94,5002 
65,0002 
49,5002

Number of logs supported Rugged TROLL 100: 1 log 
Rugged TROLL 200: 2 logs

Fastest Logging Rate 1 per second

Fastest Output Rate Rugged TROLL 200 only 
Modbus & SDI-12: 1 per second

Log Types Linear, Fast Linear, Event

Suspension Cable (use with 
backshell hanger & Rugged 
TROLL 100/200 or Rugged 
BaroTROLL)

Poly-coated 304 stainless steel 
50 ft, 150 ft, 300 ft (15.24 m, 
45.72 m, 91.44 m)

Rugged TROLL 200 Cable (use 
with Rugged TROLL 200 & 
Rugged BaroTROLL)

24/4 AWG 
RS485 with connector, 
RS485 stripped and tinned, or 
SDI-12 stripped and tinned

Rugged BaroTROLL Range: 7.0 to 30.0 psi (0.5 to 2 
bar, 0.5 to 2 atm, 14.25 to 61 
in Hg)

Docking Station  
(Rugged TROLL 100/200 & 
Rugged BaroTROLL)

USB or RS232

Rugged TROLL Com  
(use with Rugged TROLL 200 & 
 Rugged BaroTROLL)

USB or RS232 for RS485 
communications via RS485 
cable with connector

Minimum System Requirements 

Win-Situ 5: 400 MHz Pentium® II processor; 128 MB RAM, 100 MB 
free disk space; Internet Explorer® 6.01 or higher; Windows® 2000 
Professional SP4 or higher; Windows XP Professional SP2 or higher; 
Windows Vista or Windows 7; CD-ROM drive; RS232 serial port or 
USB port

Win-Situ Mobile: RuggedReader with Microsoft Windows Mobile® 

operating system (Yellow RuggedReader, Pocket PC 2003 or later; 
Blue RuggedReader, Windows Mobile 5 or later); at least 16 MB 
data storage memory (SD/CF card or built-in non-volatile memory); 
Microsoft® ActiveSync® v. 4.5 or higher for Windows 2000/Windows XP. 
For Windows 7, download and installation of the Windows® Mobile 
Device Center software is required for communication with the 
RuggedReader unit. 

Pressure Sensor  Type/Material 
(Non-Vented)

Piezoresistive; Ceramic

	 Range 30 ft (9.0 m) (Burst: 60 ft) 
100 ft (30 m) (Burst: 134 ft) 
250 ft (76 m) (Burst: 368 ft)

	 Accuracy @ 15° C Typical ± 0.1% full scale (FS)

	 Accuracy (FS) ± 0.3% FS max.3

	 Resolution ± 0.01% FS or better

	 Units of Measure 
		  Pressure 
		  Level

 
psi, kPa, bar, mbar, mmHg, 
in, ft, mm, cm, m

Temperature Sensor Silicon

	 Range Calibrated: 32 to 122° F (0 to 
50° C)

	 Accuracy ± 0.3° C

	 Resolution 0.01° C or better

	 Units of measure Fahrenheit, Celsius

1 Battery life guaranteed when used within the factory-calibrated 
temperature range
2 Data logged (no wrapping) from device within the factory-
calibrated temperature range
3 Across factory-calibrated temperature range

Rugged TROLL 100 and 200 Specifications
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Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Rugged TROLL
Model: Rugged TROLL 100
Product Description: The Rugged TROLL measures and logs level and temperature in natural

groundwater and surface water.

is in compliance with the following Directives:

89/336/EEC for Electromagnetic Compatibility (EMC) Directive
73/23/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

• Immunity
EN 61326:1997, Including Amendments A1:1998, A2:2001, A3:2003,
Electric Equipment for Measurement, Control and Laboratory Use

• Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Date of Issue: April 26, 2010

Signature:
Name: Bruce Barker
Title: Director of New Product Development

Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Rugged TROLL
Model: Rugged TROLL 200
Product Description: The Rugged TROLL measures and logs level and temperature in natural

groundwater and surface water.

is in compliance with the following Directives:

89/336/EEC for Electromagnetic Compatibility (EMC) Directive
73/23/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

• Immunity
EN 61326:1997, Including Amendments A1:1998, A2:2001, A3:2003,
Electric Equipment for Measurement, Control and Laboratory Use

• Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Date of Issue: April 26, 2010

Signature:
Name: Bruce Barker
Title: Director of New Product Development
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